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PREFACE

Welcome to AppleShare IP 6.1

This book explains how to install and set up AppleShare IP 6.1 and Mac OS 8.5 system
software. A separate book, Mac OS 8.5 Installation Manual, provides additional information
on Mac OS 8.5. See that book if you need more help installing the Mac OS.

AppleShare IP is a general purpose suite of server software that provides a variety of network
services. AppleShare IP provides file sharing, World Wide Web, mail, and print services to
clients on local area networks (LANs), intranets, and the Internet. With AppleShare IP, your
server can handle a large number of clients, and you can control security, define the type of
access for clients, and monitor your server’s activity.

New key features in AppleShare IP 6.1 include Mac OS 8.5 compatibility, the ability to
administer your server remotely (from any Web browser—capable Macintosh or PC—
compatible computer), TCP Filter software for extra security, ability to host multiple Web
sites on a server, file sharing performance improvements, ability to log in to a user’s account
with the administrator’s password, support for shared mail folders (over IMAP), a First Aid
tool for repairing key AppleShare IP data files, and LaserWriter 8.6.1 support (which provides
password-protected printing).

AppleShare IP Software Components

Here is a brief description of the AppleShare IP suite of products and where to find help for
using them. (To learn how to access Help onscreen, see “Using the Onscreen Help” on
page7.)

» The AppleShare IP Web & File Server program allows your computer to host a Web site
and provides three types of file sharing services: AppleShare File Sharing (using the Apple
Filing Protocol, or AFP) via TCP/IP or AppleTalk networks, Windows File Sharing (using the
SMB/CIES protocol via TCP/IP), and File Transfer Protocol (FTP). You manage Web and file
services on your server using the Web & File Admin program.

Help is available onscreen in Tips and AppleShare IP Help.
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The AppleShare IP Mail Server program provides integrated mail storage and mail
forwarding services over TCP/IP and AppleTalk networks, including support for Internet
Message Access Protocol (IMAPv4), Post Office Protocol (POP), and Simple Mail Transfer
Protocol (SMTP). You manage mail services on your server using the Mail Admin program.

Help is available onscreen in Tips and AppleShare IP Help.

The AppleShare IP Print Server program manages communication with the printers on
your AppleTalk or TCP/IP network by allowing the server to act as a repository for print
jobs. You can also set up secure print queues to control who can print. You manage print
services on your server using the Print Admin program.

Help is available onscreen in Tips and AppleShare IP Help.

AppleShare Client 3.8.1, while not required, provides the best AppleShare file sharing
performance when installed on Mac OS client computers.

Instructions and system requirements are available in the AppleShare Client 3.8 User’s
Manual (inside the AppleShare Client folder) on your AppleShare IP CD-ROM disc.

AppleShare IP Remote Administration allows you to remotely manage many AppleShare
IP services from any computer connected to your network using any standard Web
browser.

Help is available onscreen in AppleShare IP Remote Help.

TCP Filter software allows you to define filters that allow or deny access to an AppleShare
IP server from specified IP addresses or domain names. You can apply filters to individual
protocols (such as IMAP or FTP) or create global filters that can be applied to all TCP/IP
Services on your server computer.

Help is available onscreen in Tips and AppleShare IP Help.

MacDNS software provides Domain Name System (DNS) service for your network. You
may need DNS software in order to communicate with the Internet and to allow users to
enter names instead of numeric IP addresses when, for example, sending e-mail.

Help is available in the MacDNS Administrator’s Guide file inside the MacDNS folder in
the AppleShare IP 6.1 folder on your server’s hard disk after you've installed
AppleShare IP.

AppleShare IP also comes with additional software to help you run your servers more
effectively and efficiently. See the folders and files on your AppleShare IP CD.



After You Read This Manual

After you use this book to install and set up AppleShare IP 6.1, see the AppleShare Client 3.8
User’s Manual in the AppleShare Client folder on your AppleShare IP CD (or in the Client
Software 3.8.1 folder on your server’s hard disk) for instructions on installing the client
software. Once you've installed and set up the appropriate software on your server and client
computers, you can refer to the onscreen documentation for information about using the
software.

Using the Onscreen Help

Learning About the Mac 0S

What’s New

After you install your Mac OS 8.5 software, you can learn about new features and changes in
the Mac OS in the What's New in Mac OS file in the Mac OS Read Me Files folder on your
hard disk.

21
Rl 3 Aagr Lo M 038
Getting Help

The Help menu is your main source of “how to” information about the Mac OS. After you
install your Mac OS software, switch to the Finder, then choose Mac OS Help from the Help
menu.

Help Center

Show Balloons
Mac 0§ Help #?

If you have questions about compatibility or other late-breaking news about your software,
refer to the Read Me documents in the Mac OS Read Me Files folder on your hard disk and
the Mac OS CD-ROM disc.

For the latest information about the Mac OS, including troubleshooting and compatibility
tips, visit the Mac OS Web site:

http://www.apple.com/macos/

Welcome to AppleShare IP6.1 7
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Learning About AppleShare IP

Your main sources of information about AppleShare IP are Tips, AppleShare IP Help, and
AppleShare IP Remote Help.

After you install your AppleShare IP software, you'll also find Read Me files and other
onscreen documents in the AppleShare IP folder. These documents contain late-breaking
news on AppleShare IP or instructions on how to use other software that comes with
AppleShare IP.

For product updates and other information, visit the AppleShare IP Web site:
http://www.apple.com/appleshareip/
Tips

Tips unobtrusively remind you about the function of the AppleShare IP administration
program buttons. To use Tips, position the pointer over a button in the window of an
AppleShare IP program. The tip appears below the button.

[0 = AppleShare IPManager =—"~"'""=H
Adrmin Status

B ‘Web & File Admin: Running
@‘ ‘Web & File Server: Running——————
Open Web & File Admin | \web: Enabled

#ppleShare via TCP: Enabled
FTF: Enabled

‘windows File Sharing: Disabled

AppleShare IP Help

AppleShare IP Help provides instructions and troubleshooting information for all of the
administration programs except AppleShare IP Remote Administration. To open AppleShare
IP Help while you are using an administration program, choose AppleShare IP Help from the
Help menu. This opens AppleShare IP Help in your preferred Web browser. You can also
open AppleShare IP Help by double-clicking its icon in the AppleShare IP 6.1 folder.

AppleShare IP Remote Help

AppleShare IP Remote Help provides instructions and troubleshooting information for all of
the features of AppleShare IP Remote Administration, the application you use to administer
your server from another computer. To access Help while you are using the Remote
Administration application, click the Help link at the bottom of any Remote Administration
page in your Web browser. You can also open AppleShare IP Remote Help by double-clicking
its icon in the AppleShare IP 6.1 folder.



CHAPTER

Installing Your Software

Whether you are upgrading from a previous version of AppleShare or installing it for the first
time, you need to follow the instructions in this chapter.

This chapter tells you how to

= plan your AppleShare IP services

m prepare your computer’s environment and software

» install Mac OS 8.5 and AppleShare IP

Note: Your server should already be set up and connected to your network. If your server or
network is not set up, set it up before continuing with this chapter.

Planning Your AppleShare IP Services

Depending on the services you plan to provide to your users and on how your network is set
up, you'll need to answer the following questions before you install AppleShare IP.

»  Will your clients be connecting to the AppleShare IP server via AppleTalk, TCP/IP, or both?
»  What types of clients are on your network—Mac OS, Windows, UNIX?

= What type of physical connection (for example, Ethernet or LocalTalk) does your
AppleShare IP server have to your intranet or the Internet?

»  What is your server’s IP address, subnet mask, router address, and name server address?

» Does your network have a computer that provides Domain Name System (DNS) service,
or will you install this service? (DNS software is provided in your AppleShare IP 6.1 folder.)

Your network administrator should be able to help you answer these questions. If you do not
have a network administrator or if you need more assistance, see the TCP/IP Connections
Tutorial and the Network Configuration Setup Guide in the Tutorials folder on your
AppleShare IP CD. You may also want to consult an Internet service provider (ISP) to help
you answer these questions before continuing with your AppleShare IP installation.
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Preparing Your Computer’s Environment

Before you install your AppleShare IP software, you need to prepare your computer and its
environment by considering security issues, system (hardware and software) requirements,
and facts about upgrading.

Security

AppleShare IP uses share points, user authentication, and access privileges to protect data
from unauthorized access over a network. It also provides TCP Filter software that creates a
software-based firewall to block server access from computers with IP addresses you define.
However, someone with physical access to your computer can bypass these types of
protection. (Access privileges, for example, allow or deny access over the network; they
cannot prevent someone from opening a folder directly on the computer running
AppleShare IP.)

Note: Not all AppleShare IP services support these security measures to the same extent.
For more information, see AppleShare IP Help after you complete the instructions in this
manual.

If you have any concerns about physical security—especially if you plan to store highly
confidential information—consider putting your computer in a room with controlled access.

System Requirements

System requirements for client computers are listed in the AppleShare Client 3.8 Manual on
your AppleShare IP CD.

To install the AppleShare IP software, you need the following hardware and software:

= Hardware: Any Power Macintosh computer or Apple Workgroup Server with a G3, 604e,
604, or 601 microprocessor, or a 6500 series computer with a 603e microprocessor.

Your computer should be set up and connected to your network.

To use the AppleTalk multihoming feature of AppleShare IP, your computer must have a
Peripheral Component Interface (PCI) expansion slot. Computers with a 601 processor
and NuBus™ slots cannot use AppleTalk multihoming. On networks where AppleTalk
services are heavily used, AppleTalk multihoming can significantly reduce traffic and
increase the speed of the Web & File Server.

The AppleShare IP Print Server works only with AppleTalk-compatible LaserWriter
printers, other PostScript™ printers that support the Apple LaserWriter 8 printer driver,
and TCP-compatible printers that support the LPD/LPR protocol.

= Disk space: You need approximately 75 megabytes (MB) of disk space to install all of the
AppleShare IP software.



= Memory: You need 48 MB of random access memory (RAM) with virtual memory turned
on to run all of the AppleShare IP server programs simultaneously. To run all of the
AppleShare IP servers without turning on virtual memory, you need a minimum of 64 MB
of RAM.

= System software: Mac OS 8.5 is recommended and provided with your AppleShare IP
software. TCP Filter software requires Mac OS 8.5; all other features require Mac OS 8.1 or
later. Installation instructions for Mac OS 8.5 are provided on page 13 of this book, and in
the Mac 0S 8.5 Installation Manual that came with your software.

If You Are Upgrading Your AppleShare Software

If you are upgrading from AppleShare 3 or later or from Macintosh file sharing, you need to
be aware of the following information about preserving files and settings.

Users & Groups

If you are upgrading from AppleShare 3 or later or from Macintosh file sharing, the registered
users and groups that you've created are retained when you install AppleShare IP.

Share Points and Access Privileges

If you have share points (shared folders) on another computer that you'd like to move to
your AppleShare IP server, first follow the instructions in this manual to install and set up
AppleShare IP on the new server. Then follow the instructions for moving share points in the
Web & File section of AppleShare IP Help.

Some access privileges of share points you move may not exactly match the new access
privileges in AppleShare IP. They are converted to the closest match that provides the most
security. See the Users & Groups section of AppleShare IP Help.

Print Queues

If you're upgrading from AppleShare 3 or 4, you need to create new queues after you install
AppleShare IP.

File Sharing and Networking Software Settings

If you are upgrading from AppleShare 3 or later, the settings in your File Sharing, AppleTalk,
and TCP/IP control panels are retained. You do not need to reconfigure these control panels
as described in the section “Creating Network Settings” on page 14. You do need to perform
the other tasks in the section “Preparing Your Computer for AppleShare IP” on page 12
however.

Installing Your Software 11



12

Chapter 1

The Mail Database

If you're upgrading your AppleShare IP 5 Mail Server, make sure your Mail Server users
download all their mail before you upgrade. If you don’t empty the database before installing
the new Mail Server, you'll need to use the AppleShare IP Mail Tool 6.0 program (on the
AppleShare IP 6.1 CD) to update the previous mail database to the new version after you
install the new software.

Preparing Your Computer for AppleShare IP

Once your environment is ready, you need to prepare your computer for running
AppleShare IP by installing and configuring the appropriate software as follows:

= back up the necessary files

» install Mac OS 8.5

= set up your network identity

= setup AppleTalk

n setup TCP/IP

» set up TCP/IP and Remote Access (for modem access only)

m set up Energy Saver

» verify your computer’s date, time, and time zone

Backing Up Necessary Files

Depending on the file sharing program and system software version you've been using, you
may want to make backup copies of some files or record certain information before
proceeding.

» Ifyou're upgrading from a previous version of AppleShare or AppleShare IP, back up your
System Folder using a backup application that can copy invisible files. This allows you to
restore a copy of the previous Users & Groups Data File and the AppleShare PDS file (an
invisible file installed on every volume), and makes it possible to switch back to your
previous version of AppleShare if you desire.

When you make your backup copy, make sure that the AppleShare IP Web & File Server is
running.

= Ifyou're upgrading from Macintosh file sharing, you only need to make a backup copy of
your Users & Groups Data File, located in the Preferences folder inside the System Folder
on your startup disk.

» Ifyou're using TCP for network communication, open the TCP/IP control panel or
MacTCP control panel and write down your computer’s IP address and the IP addresses of
the subnet mask, routers, and name servers. You need to record this information before
you upgrade your system software.
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Installing Mac OS 8.5

If your computer is using a version of system software earlier than Mac OS 8.1, you need to
upgrade to a newer version of Mac OS before you install AppleShare IP. Mac OS 8.5 is
provided with your software.

Before you begin the installation, turn off disk-security software that provides password
protection and At Ease software. Then follow these steps:

Insert the Mac OS 8.5 CD-ROM disc (which came with your AppleShare IP software) into
your computer’s CD-ROM drive.

Shut down your computer.
You need to do this to start up from the Mac OS CD.
Turn on your computer while holding down the C key on your keyboard.

Your computer starts up from the CD-ROM disc. Continue holding down the C key until you
see the screen with the smiling face.

If your computer doesn't start up from the CD, see the section “You can’t start up the
computer using the Mac OS CD” in the Troubleshooting part of the Mac OS 8.5 Installation
Manual. Then continue with step 4 in this book.

Double-click the Mac OS Installer icon, then follow the instructions onscreen.

When you get to the Select Destination screen, click the Options button.

Select the checkbox next to Perform Clean Installation, then click OK.

Follow the remainder of the instructions onscreen to install Mac OS 8.5.

Important If you choose to perform a customized installation, make sure you select the
Apple Remote Access and Internet Access options. (The Internet Access option is
needed to access AppleShare IP Help and Remote Help, as well as connect to the
Internet.)

After the installation is complete, click Restart to restart your computer.

The Mac OS Setup Assistant opens.

Use the Mac OS Setup Assistant and Internet Setup Assistant to enter system settings for your
computer. Or if you prefer, you can enter these settings without the help of the Assistants by
following the instructions in “Creating Network Settings” on page 14.

Because you performed a clean installation, you need to drag any third-party software
extensions and fonts from your previous System Folder to your new System Folder, or
reinstall the third-party software.

For more information and troubleshooting help, see your Mac OS 8.5 Installation Manual.

Installing Your Software 13
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Creating Network Settings

Setting Your Network Identity

You need to set your network identity and password in the File Sharing control panel before
you can log on to the servers and make yourself the default owner of shared disks.

Note: If you used the Mac OS Setup Assistant after installing Mac OS 8.5, you can skip ahead
to “Setting Up Energy Saver” on page 23.

Important After you've installed AppleShare IP, you won't be able to change your
network identity in the File Sharing control panel. You can change these settings in
AppleShare IP, or by using the Mac OS Setup Assistant that came with your Mac OS
software.

To set up the File Sharing control panel, follow these steps:

Open the File Sharing control panel.

Click the Start/Stop tab to see the Network Identity section.

O=———————————F¥ileSharilin=———H

start/stop \/ Activity Monitor

@ Network Identity

Owner Name: ISteph Koester I

Computer Mare: Imuser\-’er |

Type your name in the Owner Name text box and press the Tab key.

You'll use this name when you log on to administer an AppleShare IP server. It will also be
the owner name for any items that you share. The name is not case-sensitive.

Type your password in the Owner Password text box and press Tab.

The password can be up to eight characters long and is case-sensitive. This is the default
password you enter to use the AppleShare IP administration programs.

Type a name for your server in the Computer Name text box.

The name can be up to 31 characters long and can contain any character except a colon (:),
equal sign (=), or Option-x (»). This name will appear in the Chooser.

Close the File Sharing control panel.
Your changes are saved and take effect immediately.

Setting Up AppleTalk

To provide file sharing, print, or mail services over AppleTalk, you need to set your AppleTalk
network connection in the AppleTalk control panel.



Note: If you used the Mac OS Setup Assistant after installing Mac OS 8.5, you can skip ahead
to “Setting Up Energy Saver” on page 23.

To set up the AppleTalk control panel, follow these steps:

Open the AppleTalk control panel.

O =——=\AnnleTak=—"~—H
Connect wia: [ Ethernet slat B1 i]
Setup
’7 Current zone: | East wing *

Choose the network connection type that you want AppleTalk to use from the “Connect via”
pop-up menu.

This setting determines the default port that your server will use to connect to your
AppleTalk network.

If the default port becomes unavailable (for example, if your Ethernet cable becomes loose),
AppleTalk will choose another available network connection type.

If your network has zones, choose the zone for your AppleShare IP Web & File Server from
the “Current zone” pop-up menu.

Zones are groups of devices arranged according to logical categories, such as usage or
geography. If your network has a router (a device used to connect networks), then it has
zones. Your server will appear in this zone in the Chooser.

If your network does not have a router, all computers connected to the network are in the
same zone, and you see “no zones available” instead of the pop-up menu.

Close the AppleTalk control panel and save your changes.

Your changes are saved and take effect immediately.

Setting Up TCP/IP

For users to share files over TCP, visit your Web site, print over TCP, or use TCP-based client
mail or FTP applications, and for you to use the TCP Filter software, you need to set your
computer’s network connections in the TCP/IP control panel. However, you don't need to
follow the instructions in this section if

= you completed the Internet Setup Assistant after installing Mac OS 8.5. Skip ahead to
“Setting Up Energy Saver” on page 23.

= your Internet service provider gave you software that automatically configures your TCP/
IP control panel. Skip ahead to “Setting Up Energy Saver” on page 23.

Installing Your Software 15



= you have already set up your TCP/IP control panel. If you will be running any AppleShare
IP services with a modem (or “dial-up”) connection to the Internet, skip ahead to “Setting
Up TCP/IP and Remote Access (for Modem Access Only)” on page 17. If you won't be
using a modem connection, skip ahead to “Setting Up Energy Saver” on page 23.
To set up the TCP/IP control panel, follow these steps:
1 Open the TCP/IP control panel.

If TCP/IP is inactive, the following message appears.

TCFP/IP is currently inactive.
Changes won't take effect until TCP/IP is made
active again.

Make TCP/IP active when closing the control
panel?

No ]H Yes ]|

Click Yes.

Choose User Mode from the Edit menu.

In the User Mode window, click Basic, if it's not already chosen. Then click OK.
The TCP/IP window shows the basic TCP/IP options.

Ei=——————""— TCP/IP
Connect via: Ethernet hd I
r— Setup

Confiqure : Manually - l
IP Address: | |
Subnet rnask: | |

Router address:

Search domains
Name server addr.:

5 Choose the network connection you are using to connect over TCP/IP from the “Connect via”
pop-up menu.

This setting determines the port that your server will use to connect to your TCP/IP network.

6 Choose Manually from the Configure pop-up menu.

16  Chapter 1
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Type the IP address for your AppleShare IP server in the IP Address text box.

An TP (Internet Protocol) address is a set of four numbers from 0 to 255, separated by dots
(for example, 172.16.54.2). It identifies your server on the network. Your network
administrator or Internet service provider should provide this address. For more
information, see the TCP/IP Connections Tutorial in the Tutorials folder on your
AppleShare IP CD.

Important Each computer has a unique IP address. Entering an incorrect address or the
IP address of another computer can cause problems with your computer and with the
network.

Type your network’s subnet mask in the “Subnet mask” text box.

Like an IP address, a subnet mask is a set of four numbers from 0 to 255, separated by dots
(for example, 222.222.222.0). Your network administrator or Internet service provider should
provide you with this information. If you leave this box blank, you will be assigned a default
subnet mask.

If your network has a router, type its IP address in the “Router address” text box.

A router is a device that connects two or more networks and directs information along the
most efficient or appropriate network path.

Type the IP address of your network’s DNS server in the “Name server addr” text box.

A DNS server lets users identify computers by name instead of by IP address. If you specify
more than one server, press Return after typing each server’s address.

If no other computer on your network provides DNS service, you can install MacDNS, an
implementation of DNS for the Mac OS. AppleShare IP Easy Setup (described in Chapter 2)
will set up and start MacDNS on your server. If you plan to use MacDNS, type the IP address
of the computer on which you will install MacDNS in the “Name Server Address” text box.

Important For users to be able to identify computers by name, and for mail services to
work properly, your network must have a domain name server.

Close the TCP/IP control panel and save the changes you have made.

Your changes take effect immediately.
Setting Up TCP/IP and Remote Access (for Modem Access Only)

If you will use this computer to run any of the AppleShare IP services with a modem (or “dial-
up”) connection to the Internet, you need to set up the TCP/IP control panel and the Remote
Access control panel.

Note: If your server uses a modem for TCP/IP connections, only AppleTalk-based services
will be available on your local network unless you have an Internet router.

Installing Your Software 17
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If you're using a dial-up connection, you probably have an account with an Internet service
provider that assigned you one or more IP addresses. How you set up TCP/IP and Remote
Access depends on whether your Internet service provider assigned your server a static or
dynamic IP address.

With static addressing, each computer on your network has a unique IP number. With
dynamic addressing, an IP address is assigned to each computer each time it connects to
your ISP. Using a dynamic IP address for your server has the following effects on the Web &
File Server:

m  Mac OS clients on your network will not be able to use TCP/IP to connect to the
AppleShare IP Web & File Server. Instead, they will have to use AppleTalk.

= Windows clients will not be able to connect to the Web & File Server.
» Users will be unable to visit your Web site.
» Users will not be able to use FTP to connect to the AppleShare IP Web & File Server.

Because of the disadvantages of using dynamic addresses, it's recommended that you obtain
a static IP address for each computer on which you will install AppleShare IP services.

If your computer uses a modem to connect to your Internet service provider and has a static
IP address, follow these steps to set up TCP/IP and Remote Access:

Open the TCP/IP control panel.

If TCP is inactive, a message appears.

TCP/IP is currently inactive.
Changes won't take effect until TCP/IP is made
active again.

Make TCP/IP active when closing the control
panel?

Mo ]H Yes ]l

Click Yes.

Choose User Mode from the Edit menu.

In the User Mode window, click Basic, if it's not already chosen. Then click OK.
The TCP/IP window shows the basic TCP/IP options.



5 Choose PPP from the “Connect via” pop-up menu.

O ——"r———=—"TCP/IP (Maclp) ———————"xH
Connect via: [ FFF ij
— Setup

Configure: [ ManuaTly B
IF Address: | |

Subnet mask: < will be supplied by server »

Router address: < will be supplied by server »

Search domains
MName server addr.:

PPP stands for “Point-to-Point Protocol,” the protocol used for remote access.
Choose Manually from the Configure pop-up menu.

7 Type your computer’s IP address in the IP Address text box, and the IP addresses of your
ISP’s domain name server in the “Name server addr” text box.

Your ISP will provide the addresses. For information about these settings, see steps 7 and 10
in “Setting Up TCP/IP” on page 15.

8 Close the TCP/AP control panel and save the changes you have made.

Your changes take effect immediately. Next you need to set up the Remote Access control
panel.

9  Open the Remote Access control panel (or the PPP control panel if you are using
Mac OS 8.1).

Installing Your Software 19



The Remote Access control panel appears.

0 =—-—-——=Remote Access=————0H

= Setup

@ Reqistered User O Guest

Marne : || |

Pazzword : | |

D Save password

Nurnber : | |

— Status

Idle.

(_options... | | connect |

10 Click the Registered User button.

11 In the Name text box, type the name your ISP assigned to you.

12 In the Password text box, type the password your ISP assigned to you.
13  Select the Save Password checkbox.

14  In the Number text box, type the phone number of your ISP.

15 Choose Modem from the Remote Access menu (or the PPP menu if you're using
Mac 0§ 8.1).

The Modem control panel appears.

0 ="——""r--—"=Modem =——"—=H
Connect via:
Setup
Modenn : [ ZCom Impact Analog 14.4 i]
Sound @ on (O off
Dialing: @ Tone () Pulze
D lgnare dial tone

16 Choose the port to which your modem is connected from the “Connect via” pop-up menu.

17  Choose the name of your modem from the Modem pop-up menu.

20 Chapter 1
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If you do not see your modem listed, you need to install your modem software. See the
documentation that came with your modem.

If you want to hear the modem when it dials, click the On button next to Sound.

If the telephone line that your modem uses supports tone dialing, click Tone. Otherwise,
click Pulse.

If the modem should not wait for a dial tone before it begins dialing, select “Ignore dial
tone.”

Close the Modem window.
In the Remote Access window (or PPP window in Mac OS 8.1), click the Options button.

The Options window appears.

Options

Redialing V Connection V Protocol \

Redial: [ Off i]

[ Cancel ] ” 0K ]l

If you want the modem to redial automatically when it fails to connect, choose “Redial main

number only” from the Redial pop-up menu.

Enter the number of times you want the modem to redial and the number of seconds to wait

between attempts.

Installing Your Software
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24 (lick the Connection tab.

The following window appears.

Options

Redialing V Connection \/ Protocol \

D Use verbosze logging
Reminders:
|z Flash icon in menu bar while connected

D Frompt every 5 minutes to maintain connection

BDisconnect if idle for minutes

cancel | [ ok ||

25 Select “Disconnect if idle.”

To change the default of 10 minutes, type a different number in the text box.

Note: The Mail Server will disconnect as soon as it has completed checking for or sending
mail.

26 Ifyou are using Mac OS 8.1, select “Connect automatically when starting TCP/IP applications.”
Then skip to step 29. (If you are using Mac OS 8.5, skip to step 27.)

Enabling this feature allows the Mail Server to maintain an open connection with the DNS
server so that it can obtain DNS information as needed (to send outgoing mail or check for
incoming mail).

27  Click the Protocol tab, then choose PPP from the pop-up menu.

The following window appears.

Options
Redialing V Connection V Protocol \

B Connect automatically when starting TCP/IP applications

E Allow error correction and compression in modern
E Uze TCP header compression
D Connect 1o a cormmand-line host:

@ Use terminal window

O Usze gonnect seript: < no script selected »

Irnpert Script... ] [ Export Soript... ]

[ cancel | |[ ok ||
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2
3

Select “Connect automatically when starting TCP/IP applications.”

Enabling this feature allows the Mail Server to maintain an open connection with the DNS
server so that it can obtain DNS information as needed (to send outgoing mail or check for
incoming mail).

To learn about the other items in this control panel, choose Show Balloons from the Help
menu and point to the item you want to learn more about.

Click OK to close the Remote Access (or PPP) control panel.

Your changes are saved and take effect immediately.

Setting Up Energy Saver

You need to set up your Energy Saver control panel so that your server doesn’t go to sleep
while it’s in use and so that it restarts if there’s a power outage.

Note: The Energy Saver control panel can be configured only on PCl-based computers. If
your computer has NuBus slots, skip this section and go to “Verifying the Computer’s Date,
Time, and Time Zone” on page 24.

To configure the Energy Saver control panel for your server, follow these steps:

Open the Energy Saver control panel.

O0=——————FnergySaver=——"————H

ar | Sleep l_ Scheduled Startup
Setup & Shutdown

Put the system to sleep whenever it's inactive for

[ Shut down instead il
of sleeping.

30 min 40 50 &0 Hewver

Sleep iz a low-power mode. YWaking up
from sleep is faster than restarting.

Show Details

If necessary, deselect the “Shut down instead of sleeping” box so it is not checked.

Drag the system sleep control to “Never.”
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4  Click the Show Details button and if necessary, deselect the “Separate timing for hard disk
sleep” so it is not checked.

OIg=———— Energy Saver=——— =

o |Sleep Scheduled Startup
Setup & Shutdown

Put the system to sleep whenever it's inactive for

[ Shut down instead il
of sleeping.

30 min 40 50 60 MNever

i 5eparate timing for display sleep

Smin 10 20 30 40 50 60 Mewer

[]5eparate timing for hard disk sleep

30 min 40 S0 60 Mever
Sleep is a low-power mode. Waking up " -
from sleep is faster than restarting. Hide Details

5 Choose Server Settings from the Preferences menu.

Server Settings

[ Restart automatically after a power failure.

[ Mever put the hard disk to sleep.

[ cancel | [[ ok ||

Select “Restart automatically after a power failure.”
Select “Never put the hard disk to sleep.”
Click OK.

© 0 N O

Close the Energy Saver control panel.

Your changes are saved and take effect immediately.

Verifying the Computer’s Date, Time, and Time Zone

Since the computer’s internal date and time settings are the source for all date and time
entries in your AppleShare IP server records, it's important to verify that the date, time, and
time zone are correct in the Date & Time control panel.
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1

Open the Date & Time control panel.

O =——Date &Time
— CurrentDate Current Time
o Je | [mmow
[ Date Formats... ] [ Time Formats... ]
—Time Zone

[ set Daylight=5Saving Time Automatically
[ Daylight-Saving Time is in effect

San Francisco isa city in the SetTime Zone
current time zone.

[ Use a Network Time Server
Time server: Apple Americas/..

Server Options...
Clock has not been synchronized.

Menu Bar Clock

®on Oor

Click the Set Time Zone button.

The city list appears.

Choose a city in your time zone. Then click OK.

Make sure your computer’s date, time, and daylight-saving time settings are correct for your

location.

If you want this server’s time to synchronize to another server’s time, select “Use a Network

Time Server.” Then click the Server Options button and select the server to synchronize to

and other options.

Close the Date & Time control panel.

Installing AppleShare IP Software

You can install the AppleShare IP software using either the Recommended Installation or the

Customized Installation procedure, as described in the following sections. Recommended

Installation is the most convenient procedure.

Installed Files

If you use the Recommended Installation procedure, the following files and folders are

installed at the root level of the hard disk.

» The AppleShare IP 6.1 folder is placed on each volume on which you install the
AppleShare IP software. It contains the following folders and files:

Installing Your Software
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= AppleShare IP 6.1 Read Me contains late-breaking information that could not be
included in this manual or the onscreen AppleShare IP Help.

» AppleShare IP Easy Setup is a program you use after installing AppleShare IP to
perform first-time setup tasks.

» The AppleShare IP First Aid folder contains the AppleShare IP First Aid application for
repairing key AppleShare IP data files, and the First Aid Read Me file.

» AppleShare IP Help and AppleShare IP Remote Help are HTML documents that explain
how to administer your servers using AppleShare IP’s administration programs.

» AppleShare IP Manager provides an easy way to access the AppleShare IP
administration programs.

» The Mail Server folder contains the Mail Admin program, the AppleShare IP Mail Tool,
the Mail Tool Read Me file, an alias to the Mail Server, and two Apple Guide (Help)
files.

» The Print Server folder contains the Print Server Admin program and two Apple Guide
(Help) files.

» The Web & File Server folder contains the Web & File Admin program, an alias to the
AppleShare IP Web & File Server, and two Apple Guide (Help) files.

» The Help Files folder contains the HTML documents for AppleShare IP Help.

» The MacDNS folder contains a Read Me file for MacDNS, the MacDNS program, and
the MacDNS Administrator’s Guide.

» SimpleText is a simple word-processing program that opens Read Me files.

» The TCP Filter folder contains the TCP Filter Admin application and two Apple Guide
(Help) files.

» The Client Software 3.8.1 folder is placed at the root level of the disk. It contains an
Installer program, the AppleShare IP Client 3.8 User’s Manual, a Read Me file, and the
AppleShare Client 3.8.1 Chooser extension.

» The Web Folder is placed at the root level of the disk. It contains a file named
Default.html (your default home page) and associated image file, Plug-ins folder, Error
Files folder, and the Remote Admin folder, which contains files for the AppleShare IP
Remote Admin application.

» The AppleShare IP Preferences folder is installed in the Preferences folder inside the
System Folder.

» The AppleShare IP Admin Libraries folder is installed in the Editors folder in the System
Folder.

» Various OpenDoc files are installed in the System Folder.
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» The following files and folders are installed in the Extensions folder inside the System
Folder:

» Apple Browser Launcher

» AppleShare IP Libraries

» AppleShare IP Mail Config

» AppleShare IP Mail Server

» AppleShare IP Print Config

» AppleShare IP Print Server

» AppleShare IP Registry

» AppleShare IP Registry API

» AppleShare IP UAM folder

» AppleShare IP Web & File

» AppleShare IP Web & File Config
» AppleShare IP Web & File Server
»  MWRuntimeLib

m PC Net Exchange

n TCP Filter

If you use the Custom Install procedure, a subset of these files and folders are installed on
your installation disk.

Performing a Recommended Installation
To install the recommended software, follow these steps:

Insert the AppleShare IP 6.1 CD-ROM disc into your computer’s CD-ROM drive and
double-click the AppleShare IP CD-ROM disc icon.

Open the AppleShare IP Installer folder.
Double-click the icon labeled AppleShare IP Install.

In the Welcome dialog box, click Continue and follow the instructions onscreen.

Installing Your Software
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5 When the following dialog box appears, click Start.

0 =---—-—————— Install AppleShare IPb. o= ———————

x Install/Remove Software

— Installation Type: | Recommended Installation i]

Click the Install button to install AppleShare IP
= AppleShare IPWeb & File 5erver

* AppleShare IP Print Server

* AppleShare IP Mail Server

* AppleShare IP Remote Admin

* AppleShare Client MNetwork Install

* TCP Filter

[ GoBack | [ start |

If other programs are open, click Continue to quit them and begin the installation.

Onscreen messages inform you of the progress of the installation. When the installation is
complete, a message prompts you to restart your Computer.

Click Restart.
Your computer restarts.
Remove the AppleShare IP CD-ROM disc from the CD-ROM drive and store it in a safe place.

Now that you've installed the AppleShare IP software, go to Chapter 2, “Setting Up
AppleShare IP,” on page 31.

Performing a Customized Installation
To perform a custom installation, follow these steps:

Insert the AppleShare IP CD-ROM disc into the CD-ROM drive and double-click the
AppleShare IP CD-ROM disc icon.

Open the AppleShare IP Installer folder.
Double-click the icon labeled AppleShare IP Install.

When the Welcome dialog box appears, click Continue and follow the instructions onscreen.



5 When the following dialog box appears, choose Customized Installation from the Installation
Type pop-up menu.

Install AppleShare IP 6.1

Install/Remove Software

— Installation Type: | Recommended Installation i]

Click the Install button to install AppleShare IP
* AppleShare IPWeb &File 5erver

* AppleShare IP Print Server

* AppleShare IP Mail Server

* AppleShare IP Remote Admin

* AppleShare Client Network Install

= TCP Filter

[ Goeack | [ start |

6 Choose Custom from the Selection pop-up menu, then deselect the AppleShare IP software
you do not want to install.

Note: Click the “i” button to the right of any item to see information about that item.

Select AppleShare IP 6.1 features to install.
Selection: [ Custom =]
Feature Size
[ D AppleShare IP Web & File Server 10,112k & |~ |
[ |z AppleShare IP Print Server 2,997 @
3 |z AppleShare P Mail Server 10,924k @
3 D AppleShare IP Rermote Admin 11,525 @
D AppleShare Client Metwork Install 6,162 @
-|
Selected size: 714K [ Cancel ] |[ 0K ]|

7  Click OK, then click Start.
If other programs are open, click Continue to quit other programs and begin the installation.

Onscreen messages inform you of the progress of the installation. When the installation is
complete, a message prompts you to restart your computer.

8 Click Restart.
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9 Remove the AppleShare IP CD-ROM disc and store it in a safe place.

Now that you've installed AppleShare IP, go to the next chapter to set up your AppleShare IP
server.
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CHAPTER

Setting Up AppleShare IP

Whether you've just upgraded from a previous version of AppleShare or installed it for the
first time, you need to follow the instructions in this chapter before you can use
AppleShare IP.

This chapter tells you how to

» use AppleShare IP Easy Setup to set up and start your AppleShare IP servers

» use the AppleShare IP Manager and Web & File Admin programs to set up users and
groups and do other required “first time” tasks

= get client users ready to use the services that AppleShare IP provides

Using AppleShare IP Easy Setup

You need to use the AppleShare IP Easy Setup program before you can use AppleShare IP.
AppleShare IP Easy Setup asks a few questions about how you plan to use AppleShare IP and
sets up your AppleShare IP servers accordingly.

31



To use AppleShare IP Easy Setup, follow these steps:

1 Open the AppleShare IP folder on your startup disk and double-click the AppleShare IP Easy
Setup icon.

m

AppleShare IP Easy Setup

Welcome to AppleShare |P Easy Setup

‘You can use AppleShare IP Easy Setup to set up the following
FEFVErS:

» ‘Web & File Server, which shares files over a network

» [Mail Server, which manages E-mail
# Print Server, which manages printers and print jobs

To continue, click the right arrow.

[4] [®]

2 (Click the right arrow in the lower-right corner of the window.

The screen that appears next depends on whether you've entered your computer’s IP
address in the TCP/IP control panel.

3 Ifyou entered your computer’s IP address in the TCP/IP control panel, click the button for a
Normal or Custom setup. Then click the right arrow.

Appleshare IP Easy Setup

Select Normal or Custom Setup

&

Click Normal if your computer connects to an Intranet and/or fo the
Internet using a service provider.

Click Custom if your computer connects to an Intranet only. This setup
is for computers that connect to networks that do not have a service
provider and that need to be set up with MacDNS.

@ MNormal (2 Custom

To continue, click the right arrow.

[«] [o]

If DNS service is available on your network, make sure Normal is selected, then click the
right arrow. Now skip ahead to “Normal Setup” on page 34.
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If DNS service is not available on your network, click Custom, then click the right arrow. Now

skip ahead to “Custom Setup” on page 36.

If you did not enter an IP address for your computer in the TCP/IP control panel, select the
networks over which you want to provide AppleShare IP services. Then click the right arrow.

Appleshare IP Easy Setup

Choose a Network Type

AppleTalk provides compatibility with client applications that only
support AppleTalk. TCP provides compitability with TCP - based client
applications and is faster than AppleTalk. “ou can choose an AppleTalk-
only setup or an &ppleTalk and TCP setup.

Click TCP and AppleTalk if you want to set up AppleShare IP so that it
provides services via TCP and AppleTalk.

Click AppleTalk if you want to set up AppleShare |P so that it provides
services via AppleTalk anly.

@ TCP and AppleTalk () AppleTalk

To continue, click the right arrow.

iy

[« [o]

If you will provide AppleShare IP services only over AppleTalk networks, click AppleTalk.

Then skip ahead to “AppleTalk Setup” on page 42.

If you will provide AppleShare IP services over TCP/IP and AppleTalk networks, click “TCP/AP
and AppleTalk.” Then click the right arrow. The following screen appears.

AppleShare IPEasy Setup =———H

Setup Requires TCP Configuration

i)
To set up AppleShare IP for AppleTalk and TCP, the TCP/IP contraol
panel must be configured. Quit AppleShare |P Easy Setup by choosing
Quit from the File menu. Confiqure the TCP/IP control panel before
running AppleShare |P Easy Setup.

For help with setting up TCP, see the "Getting Started" manual or
contact your service provider.

Ta quit, select Quit fram the File menu.

Setting Up AppleShare IP
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You need to set up your TCP/IP control panel before you can provide services over TCP/IP.
See the instructions in “Setting Up TCP/IP” on page 15. Then return to “Using AppleShare IP
Easy Setup” on page 31.

Normal Setup

You should use the Normal setup option if you already have a DNS server on your network.
When you choose Normal, AppleShare IP Easy Setup displays the following screen.

AppleShare IPEasy Setup =———H

Your AppleShare IP Serial Number

ol
Each computer that runs AppleShare I[P must have a unique serial
number. Use the serial number that came with yaur software.

Type your serial number:

To cantinue, click the right arrow.

[ [&]

Type the AppleShare IP 6.1 serial number in the text box, then click the right arrow.

Note: If you are upgrading from a previous version of AppleShare or AppleShare IP, your
previous serial number appears in the window. You do not need to enter a new serial
number.

You can find your serial number on the label of your AppleShare IP CD holder or on the
sheet you received when purchasing a new serial number. Be sure to store the serial number
in a safe place. You may also want to keep a photocopy of the number in another location.

Important The serial number comes printed on a small adhesive label. Don't put the label
on a CD-ROM disc or floppy disk. The label could come loose while inside a disk drive and
damage the drive.



AppleShare IP Easy Setup displays the following window, summarizing the services that will
be set up and the network protocols over which the services will be available.

Note: If you performed a customized installation, this window will only show information
for the servers that have been installed on this computer.

AppleShare IP Easy Setup

Set Up Servers

Z)

AppleShare | P Easy Setup will set up your computer to:

= Enable users to use AppleShare Client software to connect to the Web
& File Server via AppleTalk and TCP.

» Enable users to use FTP applications to connect to the Web & File
Server via TCP.

® Enable uzers to use Web browsers to wisit your 'Web site.

& Manage E-rnail wia AppleTalk and TCP.

» Manage printers wia AppleTalk.

Set Up Servers

To continue, click the right arrow.

[«1 [2]

Click the Set Up Servers button.
When the server setup is complete, click OK.
Click the right arrow.

The following window appears.

AppleShare IP Easy Setup

Easy Setup Starts Servers

Z)

Easy Setup will start the servers that have been set up by default.

If you do not want Eazy Setup to start the servers that have been
installed on your computer, click the Start Servers checkbox so
that the % disappears.

[ Start Servers

To continue, click the right arrow.

[«1 [2]

By default, AppleShare IP Easy Setup will start the servers that are installed on your
computer. If you don’t want to start the servers now, deselect the checkbox.

Setting Up AppleShare IP
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4  Click the right arrow.

If the Start Servers box was checked, AppleShare IP Easy Setup starts the servers and displays
a progress bar. The following window appears.

Appleshare IP Easy Setup

AppleShare |P Setup Complete

You can quit AppleShare |P Easy Setup by selecting Quit from the
File menu, or you can click the Start Manager button to start the
AppleShare |P Manager. The &dppleShare IP Manager provides an
easl wal to administer the AppleShare |P servers.

If you have selected the default selection Start Servers, from the
previous panel, the servers will start up prior to starting the

Manager.
Start Manager

To quit, select Quit fram the File menu.

|l [»

5 Click the Start Manager button.

The AppleShare IP Manager opens. The AppleShare IP Manager provides a convenient
central point for administering the AppleShare IP server programs.

Now skip ahead to “Using AppleShare IP for the First Time” on page 45.

Custom Setup

You need to follow the Custom Setup procedure if DNS service is not available on your
network. Custom Setup guides you through the process of setting up MacDNS, a domain
name system program that comes with AppleShare IP.

Important If you use Custom Setup, you need to configure your MacDNS file after you've
finished using Easy Setup. For instructions, see the MacDNS Administrator’s Guide in the
MacDNS folder inside the AppleShare IP 6.1 folder on your startup disk.
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After you choose the Custom Setup option, AppleShare IP Easy Setup displays the following
window.

m

AppleShare IP Easy Setup

Your AppleShare IP Serial Number

Z)

Each computer that runs AppleShare I[P must have a unique serial
number. Use the serial number that came with your software.

Type your serial number:

To continue, click the right arrow.

[al [>]

Type the AppleShare IP serial number in the text box, then click the right arrow.

Note: Ifyou are upgrading from a previous version of AppleShare or AppleShare IP, your
previous serial number appears in the window. You do not need to enter a new serial
number.

You can find your serial number on the label of your AppleShare IP CD holder or on the
sheet you received when purchasing a new serial number. Be sure to store the serial number
in a safe place. You may also want to keep a photocopy of the number in another location.

Important For convenience, the serial number comes printed on a small adhesive label.
Don't put the adhesive label on a CD-ROM disc or floppy disk). The label could come loose
while inside a disk drive and damage the drive.

Setting Up AppleShare I[P 37



AppleShare IP Easy Setup displays the following window, summarizing the information that
you need to provide.

Appleshare IP Easy Setup

MacDHNS Setup

g

AppleShare |P Easy Setup will set up MacDNS on this computer and will
ask you for the following information.

= your domain name

= the DNS name of your computer
® the E-mail address of the administrator of this computer

To continue, click the right arrow.

[«] [o]

2 (Click the right arrow.

The following window appears.

AppleShare IP Easy Setup =c—o-—=H

Your Domain Name

& domain name is a name far & group of computers. Here are some
examples:

yourdomain.com
yourdomain.edu
yourdomain.goy

Enter your computer's domain name:

yaurdommainedu.

To continue, click the right arrow.

[al [>]

3 Type your organization’s domain name in the text box.

This is the name by which the computers on your network are known to the DNS service on
your network—for example, “yourdomain.edu.” Your network administrator (or Internet
service provider) should provide you with this name.
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Note: After you've finished setting up AppleShare IP, you can learn more about the DNS in
AppleShare IP Help or in the MacDNS Administrator’s Guide in the MacDNS folder inside the
AppleShare IP 6.1 folder.

4 Click the right arrow button.

The following window appears.

AppleShare IPEasy Setup =———=—H

Your Computer Domain Name
eh

The Domain Marme Systern (DNS) associates the name of each computer
with its |P address.

To use TCP, your computer must have a domain name. You can use
Tetters, numbers, and the dash £-J character to make a DNS name. It
must begin with a letter.

Enter your computer's DNS name:

computername.yourdomain.edu.

To continue, click the right arrow.

[al [»]

5 Type your computer’s DNS name in the text box.

The DNS name is the name that your DNS server associates with your computer’s unique IP
address when communication with that address is taking place. Users can connect to your
server by entering an easy-to-remember name in place of an IP address.

A DNS name cannot contain spaces, punctuation, or Option-key characters. You may want to
use a name that is similar to the computer name defined in the File Sharing control panel.

For example, if your computer’s name is “Mt. Shasta,” its DNS name can be “shasta” or
“mtshasta,” but it cannot be “Mt. Shasta” or “mt.shasta.”

Note: If you will be turning on Windows file sharing service, the DNS name should be less
than 13 characters.

6 Click the right arrow.
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The following window appears.

m

AppleShare IP Easy Setup

Your Administrator's E- mail Address

Z)

MacDHS will send E-mail to anadministrator if it cannot work
properly. Here is an example of an E-mail address:

terry@yourdomain.edu
Mote: Enter the E-mail address now, even if you haven't set up mail

for the administrator yet. Be sure to set it up as soon as possible.

Enter the E-mail address of this computer's administratar:

uzername&yaurdomain.edu.

To continue, elick the right arrow.

[al [2]

Type the e-mail address of the person who should receive mail if a problem arises.
Click the right arrow button.

The following window appears, summarizing the services that will be set up and the network
protocols over which the services will be available.

AppleShare IP Easy Setup

Set Up Servers

Z)

AppleShare |P Easy Setup will set up your computer to:

= Enable users to use AppleShare Client software to connect to the Web
& File Server via AppleTalk and TCP.

= Enable users to use FTF applications to connect to the Web & File
Server via TCP.

® Enable users to use Web browsers to visit your Web site.

® [Manage E-mail wia &ppleTalk and TCP.

& Manage printers wia AppleTalk.

® Provide DNS service.
Set Up Servers

To continue, click the right arrow.

[«1 [o]

9 C(lick the Set Up Servers button.
When the server setup is complete, click OK.

10 Click the right arrow.
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The following window appears.

AppleShare IP Easy Setup

Easy Setup Starts Servers

Easy Setup will start the servers that have been set up by default.

If you do not want Eazy Setup to start the servers that have been
installed on your computer, click the Start Servers checkbox so
that the % disappears.

[ Start Servers

To continue, click the right arrow.

[«1 [2]

By default, AppleShare IP Easy Setup will start the servers that are installed on your
computer. If you don’t want to start the servers now, deselect the checkbox.

Click the right arrow.

If Start Servers was checked, AppleShare IP Easy Setup starts the servers and displays a
progress bar. The following window appears.

Appleshare IP Easy Setup

AppleShare |P Setup Complete

(S

‘You can quit AppleShare [P Easy Setup by selecting Quit from the
File menu, or you can click the Start Manager button to start the
AppleShare |P Manager. The AppleShare |P Manager provides an
easy way to administer the AppleShare |P servers.

If you have selected the default selection Start Servers, from the

previous panel, the servers will start up prior to starting the
Manager.

Start Manager

To quit, select Quit from the File menu.

[l [

Click the Start Manager button.

The AppleShare IP Manager opens. The AppleShare IP Manager provides a convenient
central point for administering the AppleShare IP server programs.
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13

14

Complete your MacDNS setup by adding the required information about each server on your
network to your MacDNS configuration file.

For instructions, see the MacDNS Administrator’s Guide in the MacDNS folder inside the
AppleShare IP 6.1 folder on your startup disk.

Note: Users will not be able to access AppleShare IP services by use of a domain name until
you configure your DNS file.

After you've finished updating your MacDNS configuration file, go to “Using AppleShare IP
for the First Time” on page 45.

AppleTalk Setup

You should choose AppleTalk if you plan to provide AppleShare IP services only over an
AppleTalk network. After you choose AppleTalk, AppleShare IP Easy Setup displays the
following window.

m

AppleShare IP Easy Setup

Your AppleShare IP Serial Number

Z)

Each computer that runs AppleShare I[P must have a unique serial
number. Use the serial number that came with your software.

Type your serial number:

To cantinue, click the right arrow.

[ [&]

Type the AppleShare IP serial number in the text box, then click the right arrow.

Note: If you are upgrading from a previous version of AppleShare or AppleShare IP, your
previous serial number appears in the window. You do not need to enter a new serial
number.

You can find your serial number on the label of your AppleShare IP CD holder or on the
sheet you received when purchasing a new serial number. Be sure to store the serial number
in a safe place. You may also want to keep a photocopy of the number in another location.



AppleShare IP Easy Setup displays the following window, summarizing the services that will

be set up and the network protocol over which the services will be available.

Appleshare IP Easy Setup

Set Up Servers

g

AppleShare | P Easy Setup will set up your computer to:

» Enable users to use AppleShare Client software to connect to the Web
% File Server via &ppleTalk.

» [Manage E-mail wia &ppleTalk.

& Manage printers wia AppleTalk.

TCP services will not be enabled.

Set Up Servers

To continue, click the right arrow.

[«] [o]

Note: If you performed a customized installation, this window will only show information
for the servers that have been installed on this computer.

Click the Set Up Servers button.
When the server setup is complete, click OK.
Click the right arrow.

The following window appears.

Appleshare IP Easy Setup

Easy Setup Starts Servers

£
Easy Setup will start the servers that have been set up by default.
If you do not want Easy Setup to start the servers that have been

installed on your computer, click the Start Servers checkbox so
that the ¥ disappears.

[ Start Servers

To continue, click the right arrow.

[« [o]

Setting Up AppleShare IP
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By default, AppleShare IP Easy Setup will start the servers that are installed on your
computer. If you don’t want to start the servers now, deselect the checkbox.

4 Click the right arrow.

If the Start Servers checkbox was checked, AppleShare IP Easy Setup starts the servers and
displays a progress bar. The following window appears.

ApplesShare IP Easy Setup =————

AppleShare |P Setup Complete

‘You can quit AppleShare [P Easy Setup by selecting Quit from the
File menu, or you can click the Start Manager button to start the
AppleShare |P Manager. The AppleShare |P Manager provides an
easy way to administer the AppleShare |P servers.

If you have selected the default selection Start Servers, from the

previous panel, the servers will start up prior to starting the
Manager.

Start Manager

To quit, select Quit from the File menu.

[l [

5 Click the Start Manager button.

The AppleShare IP Manager opens. The AppleShare IP Manager provides a convenient
central point for administering the AppleShare IP server programs.

Go to “Using AppleShare IP for the First Time” on page 45.
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Using AppleShare IP for the First Time

If you clicked the Start Manager button at the conclusion of the AppleShare IP Easy Setup
program, the AppleShare IP Manager window appears. (If you don'’t see this window, open
the AppleShare IP Manager by double-clicking its icon in the AppleShare IP 6.1 folder.)

AppleShare IP Manager =—"—H

Adrmin Status

Rt ‘web & File Admin: Not Running
@‘ ‘web & File Server: Running
‘weh: Enabled
AppleShare via TCP: Enabled
FTF: Enabled
‘Windows File Sharing: Disabled

Mail Admin: Mot Running
i Mail Serwver: Running

IMAP: Enabled
POP: Enabled
SMTP: Enabled

Print Admin: Not Running
Q Print Server: Running

The AppleShare IP Manager window displays status information about the servers installed
on your computer and provides an easy way to open server administration programs. To
open an administration program, click a button along the left side of the window, or choose
a command—for example, Open Web & File Admin—from the File menu.

In this section, you'll use the AppleShare IP Manager to access the administration programs
and perform the following final setup tasks:

register a user

set up AppleShare file sharing and FTP services by creating a share point
set up Web service by setting access privileges to the Web Folder

turn on Windows file sharing (if you have Windows clients)

turn on AppleShare IP Remote Administration

set up mail service by turning on mail for registered users

set up print service by creating a print queue

Note: This section takes you through the first-time setup tasks that are required to provide
AppleShare IP services to your users. In some cases, more detailed information is available in
AppleShare IP Help. After you complete the instructions in this manual, you may want to
review these tasks in AppleShare IP Help.
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Registering a User for the First Time

If this is the first time you've used a version of AppleShare on your computer, you need to
register the users who will have access to your servers. Each registered user has a name and
(optionally) a password that authenticates the user when he or she logs on.

In this section, you'll create just one user. After you've completed this chapter, refer to the
instructions in AppleShare IP Help to register additional users and learn about creating
groups, enabling guest access, and related tasks.

If you upgraded from a previous version of AppleShare or Macintosh file sharing, the users
and groups you created are still available. You can skip this section and go to “Setting Up
Share Points for the First Time” on page 49.

Note: You can create registered users through the Web & File Admin program or the Mail
Admin program. This chapter shows you how to register users through the Web & File
Admin program.

To register a user through the Web & File Admin program, follow these steps:

In the AppleShare IP Manager window, click the Web & File Admin button.

A dialog box appears. The Owner Name that you entered in the File Sharing control panel
appears in the Administrator Name field.

Administer Web & File Server

Administrator Name: |Steph Koester

Password: [|

(o) (5]

Type in the Password text box the Owner Password that you entered in the File Sharing
control panel.

3 Click OK.



The Web & File Server Activity window appears.

0 =—"—————Web &file Serverartivity>"—~———0 8
Status: Mot Running Current User dctivity: | I —
Mame: myserver Set Maximum: Min =—(fl——Max
Connected Users: 0 Guest Access: File: On FTP: Off
99\ Web: On Windows: Off
(day hr:min} {day hr:min}
Connected User Connection Type Connected For Idle For

[»

KN

4 Choose Show Users & Groups List from the Users menu.

The Users & Groups List appears.

Users & Groups List —=————C[EI8

MNarne Kind Last Log On
& Guest Guest 1=
@ Mail Administrator Dizabled User MNewer
3 steph Koester administrator  5/26/98, 12:46 PM
[+
2 Users, 0 Groups | 4 [l e

5  Click the New User button at the top-left side of the window to create a new user.

A new user is added to the Users & Groups List, and a User window appears.

0 =———user: untitled | =—"—m—=H

[ General - |

Name: [untitled 1 | Passwerd: |

Inter net Alias: | |

[ Enable user to administer the server
[ Program Tinking

User maylogon  [] Disable logon as of:| S/ 6/93 @

User may change password

[ Require new password an next lag on

(Revert ) ([Saze )
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Type your new user’s name in the Name text box.
The name can be up to 31 characters long and is not case-sensitive.

The name is also used by the Mail Server to identify the user when his or her e-mail
application logs on to the Mail Server.

Important If this user will be connecting to the Web & File Server for Windows file sharing
services, enter the name that the user enters to log on to his or her Windows computer.

To assign this user a password, type it in the Password text box.

Assigning a password is highly recommended, and required for some client e-mail and FTP
applications. A password can be up to eight characters long and is case-sensitive. For each
character that you type, a bullet appears, so it is important to record what you type. (Be sure
to note whether the Caps Lock key is pressed.)

For increased security, use eight-character passwords with a combination of letters and
numbers.

If this user will be using the Mail Server, don’t use spaces and special characters. (Some client
mail applications do not recognize special characters or spaces.)

Important If this user will be connecting to the Web & File Server for Windows file sharing
services, enter the password that the user enters to log on to his or her Windows computer.

To give this user an Internet alias when logging on to an AppleShare IP server, enter a name
in the Internet Alias text box.

You need to assign an alias if this user will be using mail or FTP services and the user name
contains spaces or special characters. The alias should contain only numbers and unaccented
uppercase and lowercase letters.

The user enters this alias to connect to the Web & File Server. The Mail Server uses this alias
to identify the user’s mail application.

Note: If the user name does not include spaces or special characters, an Internet alias is not
necessary.

Click Save.

The new user is created and appears in the Users & Groups List window.

Note: If the Owner Name of the computer includes spaces or special characters, you should
assign yourself an Internet alias now. Double-click the name in the Users & Groups List
window, enter an Internet alias using the guidelines in step 8, then click Save. You can use
your Internet alias to log on to administer any AppleShare IP servers for which you are the
administrator.



10 Complete the rest of this chapter, then go to the Users & Groups section in AppleShare IP
Help to register your remaining users. You can repeat steps 59 above to register all of your
users now. However, many options and tips for quickly and efficiently setting up large
numbers of users and groups are described in AppleShare IP Help.

Setting Up Share Points for the First Time

To make available AppleShare or Windows file sharing or FTP services, you need to specify a
disk, CD-ROM disc, or folder as a share point and assign it access privileges. A share point is a
disk, CD-ROM disc, or folder that is made available to users on a network.

Important If you're planning to turn on FTP or Windows file sharing services, make sure
the names of shared hard disks, folders, or files contain fewer than 13 characters and no
spaces or Option-key characters. If you need to change the names of any share points in
the Finder, do so now.

If you upgraded from AppleShare 3 or 4, or AppleShare IP 5 or 6, previous shared items are
still being shared. Skip ahead to “Setting Up Remote Administration for the First Time” on
page 56.

To create a share point, follow these steps:
1 Open the Web & File Admin program.

Click the Web and File Admin button in the AppleShare IP Manager. Enter your name and
password in the dialog box, then click OK.

The Web & File Server Activity window appears.

2 If AppleShare IP Easy Setup didn’t start the Web & File Server for you, choose Start Web &
File Server from the Server menu.

A message indicates that the Web & File Server is starting up. When the status line in the
upper-left corner of the Web & File Server Activity window indicates that the Web & File
Server is running, go to step 3.

3 Choose Show Disks & Share Points from the Server menu.
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The Disks & Share Points window appears.

0O ="————Disks &Share Points =c"—"———— M1 8
Show: @ Disks
SENL= (3 Share Points
Name Kind
> = HardDisk disk =
[~
o [l [

The names of your hard disks and any CD-ROM discs appear in the Disks & Share Points
window.

4  Click the triangle to the left of an item to display its contents.

0O =-"-"—"——"—————Disks &Share tints =—"————H B
Show: @ Disks
SHNI=! ) Share Points
Name Kind
= (=3 HardDizsk disk =
I Ei &pple Extras folder =
b [ appleshare 1P 6.1 folder
I ﬁ appleShare |P Mail Folder folder
I ﬁ APPLICATIONS folder
I ﬁ &asistants folder
b [ client Software 3.8 folder —
11 D

5 Select the disk, CD-ROM disc, or folder that you wish to share.

If you select a disk, every folder on it (except the System Folder on a startup disk) will be
available to users who log on to the Web & File Server. If you select a folder, everything in the
folder (including enclosed folders and their contents) will be shared.

6 Click the Privileges button.

Chapter 2



The Privileges window for the selected disk or folder appears.

O =]

Privileges: Client Software 3.8

Select Privileges
) Use enclosing item's privileges
(2} Set privileges for this item
(2} Make this a share point and et privileges

Show Users & Groups List

Owner: @ Steph Koester &ﬁ EI
User/Group: = lzl
- ]

Everyone:

2]

@ Make all enclozed folders like this one

] Can't move, rename, or delete this folder

Revert Save

d

7  Click the button labeled “Make this a share point and set privileges.”

All of the folders that a share point contains are also shared. For security reasons, it’s often
better to share folders instead of entire disks.

8 Choose the appropriate access privileges for the Everyone category.

As the administrator of this computer, you are the default owner of all volumes and the
folders they contain. By default the owner has Read and Write access privileges (meaning you
can open or make changes to shared items).

The Everyone category includes everyone listed in the Users & Groups List (including the
guest user). Following are brief descriptions of each privilege:

= Read & Write: Allows users in this category to see, open, and copy files and make
changes to the contents of the share point (including creating, deleting, moving, and
modifying files).

= Read Only: Allows users in this category to see, open, and copy files.

= Write Only: Allows users in this category to change the contents of the share point by
moving files and folders into it, but not to see files or folders. A folder with the Write Only
privilege is also known as a drop box.

» None: Users in this category have no access to the folder or files of this share point.
Later you can further restrict access to this share point by selecting a user or group that will
have different privileges, or you can set different privileges for certain folders. You can learn

more about access privileges and related topics in the Web & File section of AppleShare IP
Help.
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10

11

Click Save.

In the Disks & Share Points window, the icon for the disk, CD-ROM disc, or folder you've
selected changes to indicate that the item is shared.

Now when anyone in the Users & Groups List logs on to the Web & File Server via TCP/IP or
AppleTalk, he or she will be able to access this share point to the extent of the access
privileges you've set.

If you wish, repeat steps 5-9 to create more share points.

You can also wait to create your remaining share points until you've completed the
instructions in this manual.

Close the Disks & Share Points window.

You've completed your file sharing setup. To set up Web service, go to the next section.

Setting Up Web Service for the First Time

Web service and guest access to Web services is turned on by default. However, you need to
define the access privileges you want users to have to the Web Folder. To make sure no one
alters the contents of your Web site, you should assign Read Only access privileges to the
Everyone category for the Web Folder share point.

Note: If you want to put your Web files in another folder, use a different home page name,
or host multiple Web sites on your server, you need to perform additional steps. See the Web
& File Server section of AppleShare IP Help for more information.

To set access privileges to the Web Folder, follow these steps:
Open the Web & File Admin program.

Click the Web & File Admin button in the AppleShare IP Manager. Enter your name and
password in the Administer Web & File Server dialog box, then click OK.

The Web & File Server Activity window appears.

If AppleShare IP Easy Setup didn’t start the Web & File Server for you, choose Start Web &
File Server from the Server menu.

A message indicates that the Web & File Server is starting up. When the status line in the
upper-left corner of the Web & File Server Activity window indicates that the Web & File
Server is running, go to step 3.

Choose Show Disks & Share Points from the Server menu.

The Disks & Share Points window appears.



4 Select Web Folder at the root level of your AppleShare IP server’s hard disk.

O Disks & Share Points ="rce—————[1 8
i . Disks
= Show: @
@ ) Share Points
Name Kind
I ﬁ Internet folder -
b [ Mac0S Read Me Files folder
I ﬁ My Personal wWeb Site faldar
I ﬁ Stationery folder
b utilities folder
b W web Folder folder =
13 § ‘web Pages folder ~
oA i) 1» |2

5 Click the Privileges button (or double-click the Web Folder).

The Privileges window for the Web Folder appears.

[0 ==—— privileges: Web Folder =—i—"—8

Select Privileges
@ Use enclosing item’s privileges
(2} Set privileges for this item
() Make this a share point and set privileges

Show Users & Groups List
Owner: @ Steph Koester 6"?

User /Group:

qiKiK

Everyone:

Make all enclosed folders like this one

[ can‘t move, rename, or delete this folder

G

6 Click the button labeled “Set privileges for this item.”

7 Choose Read Only from the Everyone pop-up menu, and make sure Read & Write is selected
for the Owner category.

“Everyone” includes everyone listed in the Users & Groups List (including guest users).
Choosing Read Only means any registered user or guest can view the contents of your Web
Folder, but cannot change its contents. For descriptions of each privilege, see “Setting Up
Share Points for the First Time” on page 49.
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As the administrator of this computer, you are the default owner of all volumes and the
folders they contain. By default the owner has Read and Write access privileges (meaning you
can open or make changes to shared items).

Click Save.

If you have a Mac OS—only network, skip ahead to “Setting Up Remote Administration for the
First Time” on page 56. If there are any Windows clients on your network, continue to the
next section.

Setting Up Windows File Sharing for the First Time

If any Windows or Windows NT computers will connect to your AppleShare IP server, you
need to configure your Web & File Server for Windows file sharing and make sure the
appropriate networking software is installed on your Windows clients.

In this section, you'll set up a network in which all your Windows clients are on the same
subnetwork (or subnet) as your AppleShare IP Web & File Server.

If your Windows clients are not on the same subnet as the Web & File Server, you should
read this section, complete the instructions in the remainder of this manual, then set up
your network for AppleShare IP Windows file sharing following the instructions in the
Windows File Sharing section in the Web & File section in AppleShare IP Help.

Note: Windows file sharing requires TCP/IP. If you have not already set up your TCP/IP
control panel, follow the instructions in “Setting Up TCP/IP” on page 15 before continuing
with this section.

To set up Windows file sharing when your Windows clients are on the same subnet as the
Web & File Server, follow these steps:

Open the Web & File Admin program.

Click the Web & File Admin button in the AppleShare IP Manager. Enter your name and
password in the dialog box, then click OK.

The Web & File Server Activity window appears.
Choose Web & File Server Settings from the Server menu.

The Web & File Server Settings window appears.

3 Choose Windows File Sharing from the Web & File Server Settings pop-up menu.



4
5

10

The Windows File Sharing panel appears.

O ==——=Wweb &File Server Settings =——H

[ Windows File Sharing v |

[ Enabile 'indows File Sharing (SMB)

Server Name: [muyserver |

workgroup: [WORKGROUP |

Description: [AppleSharelP |

[ Enable "I NS Registration

WINS Server: | |

G

Select the “Enable Windows File Sharing” checkbox.
If necessary, enter a new name for the Web & File Server in the Server Name text field.

By default, the Web & File Server assigns the AppleShare IP server’s unqualified DNS name
(the name before the first dot) as the Windows file sharing server name. (For example, an
AppleShare IP server with the DNS name “myserver.company.com” has “myserver” as the
unqualified Windows server name.) Apple recommends you use the name provided because
that makes it easier for some clients to connect to the Web & File Server.

If you decide to change the server name, it must be a valid Windows host name with 15
characters or fewer and no special characters or punctuation (such as A[]: +"| <>=;*? or
space).

Type the workgroup name for your server in the Workgroup text field.

Windows computers use the workgroup name to describe their local group of computers on
the network. Consult your Windows network administrator for the correct name.

If you like, type a description for the server in the Description text box.

You can enter up to 48 characters. Users see this information in their Network
Neighborhood. You may want to enter your name and phone number so users know whom
to contact for information.

Click Save.
Close the Web & File Server settings dialog box.
Restart the Web & File Server.
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13

If the server is running, choose Stop Web & File Server from the Server menu. After the
server stops, choose Start Web & File Server from the Server menu.

Make sure you've created at least one share point with a valid Windows folder name.

The name should have fewer than 13 characters and no special characters or punctuation.

For instructions on creating a share point, see “Setting Up Share Points for the First Time” on

page 49.

Make sure the following networking software is installed and configured on each of your

Windows clients:

= Windows 98 or Windows 95 clients: Client for Microsoft Networks, TCP/IP Protocol, and
File and Print Sharing for Microsoft Networks

»  Windows NT clients: Workstation and TCP/IP Protocol software

For instructions on installing or configuring this software, see your Windows software
documentation.

On a Windows computer on your network, connect to the Web & File Server using the
Network Neighborhood.

Open the Network Neighborhood window. It may take an hour or more before the Web &
File Server appears. Double-click the icon to connect to the server.

IE‘_EI_ Hetwork Neighborhood M= E3
File Edit ‘iew Help

| Comment
Entire Metwork
AppleSharelP

|2 object(s] v

Users in a different workgroup need to double-click the Entire Network icon, double-click
the correct workgroup icon, and double-click the Web & File Server icon.

Setting Up Remote Administration for the First Time

AppleShare IP Remote Administration provides a secure way to perform many server
administration tasks from any Macintosh or PC—compatible computer connected to your
network using any standard Web browser.

To use Web browser—based remote administration in AppleShare IP, you need to set it up in
the Web & File Admin program. You must be designated as an administrator in the program’s
Users & Group List.

Note: For extra security, you can use TCP Filter Admin to prevent access to the
AppleShare IP Remote Admin application from any computer. See the TCP Filter Admin
section of AppleShare IP Help for details.



1 Open the Web & File Admin program.

Click the Web & File Admin button in the AppleShare IP Manager. Enter your name and
password, then click OK.

The Web & File Server Activity window appears.

2 Make sure the Web & File Server is running by checking the status line in the upper-left
corner of the Web & File Server Activity window.

Ifit’s not running, choose Start Web & File Server from the Server menu.

3 Choose Web & File Server Settings from the Server menu.

0 === Web &file 5erver Settings =——=H

[ General -

‘Weh & File Server Name: | ASIP West

[ Start web & File Server on System Startup

File Server and FTP Client Connections: Max
Guest Connections: Max

[ &1 10w remote administration via a Web browser

=

4 Select “Allow remote administration via a Web browser.”

5 Choose Web from the pop-up menu.

O === 'web & File Server SEttinQSEE

[ web -]

[ Enable Web Service

Client Connections: Max

[ Enable wWeb Log

[# Enable directory listing
qa Current Web Folder:
Lab # &:web Falder:
5 Current Default Home Page File:
Lab # 4\web Folder:Default.html

G
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6 Select Enable Web Service.
7 Click Save.

Your changes take effect immediately.

To administer AppleShare IP services, type the following Remote Admin URL in any industry-
standard Web browser:

http://<your Web server’s DNS name>/.admin

After you've set up your services, you can learn more about using Remote Admin in
AppleShare IP Remote Help.

Now go to the next section to set up the Mail Server.

Setting Up the Mail Server for the First Time

For users to send and receive e-mail messages via TCP or AppleTalk, you need to enable mail
service for each user.

If you're upgrading from a previous version of the AppleShare Mail Server, your users and
groups mail settings are still valid. You can skip this section and go to “Setting Up the Print
Server for the First Time” on page 61.

Note: If you want to enable mail services for a large number of users, you can create a
spreadsheet with the necessary information and import it. For instructions, see the Users &
Groups section of AppleShare IP Help after completing the remaining instructions in this
manual.

To set up mail for registered users, follow these steps:
Click the Mail Admin button in the AppleShare IP Manager window.
Enter your name and password. Then click OK.

The Mail Server Activity window appears.

Mail Server Activity i—"=——=H

- Server Status: Running
|

Mail Storage

Wolume: HardDisk

Size: 520 K

Number of Messages: 0

2 (lick the Users & Groups List button.



3 Inthe Users & Groups List window, double-click the name of a user for whom you want to
enable mail.
The User window appears.

Note: If you're installing AppleShare IP for the first time and following the instructions in
this manual, you may only have one registered user, besides yourself, in the Users & Groups
List. After you've created your remaining users, don't forget to set up mail for them too.

4 If the user’s name contains spaces or special characters, make sure there is a name in the
Internet Alias text box.

For information on entering a valid Internet alias, see “Registering a User for the First Time”
on page 46.

5 Choose Mail Settings from the pop-up menu in the User window.

[0 = User:Ethan Switzer=——8

[ Mail Settings -]

E- mail Address: ethan1@mailcompanycom

Account: @ None (Z) Enable  {2) Forward

The mail server does not accept mail for
s this user.

(Cave ]

The user’s e-mail address appears below the pop-up menu. If the user has an Internet alias,
the Mail Server uses it in the e-mail address.

Important This is the address that others should use to send mail to this user. Be sure to
tell this user to enter this address as the return address when setting up his or her mail
application.

Note: If the e-mail address shows the user’s Internet alias followed by the Mail Server’s IP
address (for example, ethan1@172.16.54.2), then DNS service may not be set up on your
network. You need to set up DNS service if your network is connected to the Internet or if
you want your users to be able to send mail to domain names instead of IP addresses. To set
up MacDNS, an implementation of DNS service that comes with AppleShare IP, follow the
custom setup instructions on “Using AppleShare IP Easy Setup” on page 31.
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6 Click the Enable button.

When mail is enabled, the user can connect to this computer for mail service. The User
window shows the user’s mail account name below the Enable button.

[0 =-———User: Ethan Switzer =—"~"—H

[ Mail Settings |

E-mail Address: mailcompanycom
Account: ) Mone @ Enable (2 Forward
Account Name: ethan i

Select the access method for the user's mail account:
() POP only

() IMAP only

@ Eoth POP and IMAP

CGe=J

Important Be sure to tell this user to enter this account name and the password you
assigned in the General panel when setting up his or her log-on information in a mail
application.

Click Save.

Mail is set up for this user. He or she can configure and use any client e-mail application that
supports both the POP and IMAP protocols. For more information about these protocols or
other mail settings, see the Mail Server section of AppleShare IP Help after you complete the
remaining instructions in this manual.

If the Mail Server is not already running, choose Start Mail Server from the Mail Admin
program’s Server menu.

Important If you install the AppleShare IP Mail Server on more than one computer (which
requires the purchase of an additional copy of AppleShare IP), you need to coordinate the
flow of mail among all of the computers that provide mail service. Depending on your
network configuration, you may also need to set up the Mail Server so that it forwards or
relays mail to other servers. Be sure to review mail service and mail forwarding in the Mail
Server section of AppleShare IP Help after you've completed this chapter. You should also
review your license agreement.

The Mail Server is now set up. Go to the next section to set up the Print Server.



Setting Up the Print Server for the First Time

The Print Server lets you set up queues. A queue contains a list of print jobs that are being
stored on the Print Server. The queue also attaches printers to those jobs and sends the jobs
through one at a time. If you set up queues for printing, users can continue to work while
they are waiting for a document to print. If you attach multiple printers to a queue, several
documents can print at the same time on different printers, which reduces the wait time for
printing.

You need to create at least one print queue with one printer attached before you can use the
Print Server. This section describes setting up an AppleTalk printer queue. For instructions on
connecting a printer over TCP/IP, see the Print Server section of AppleShare IP Help after you
complete the remaining instructions in this manual.

To create a queue and attach a printer, follow these steps:

1 Make sure that any printers you'd like to attach to your print queue are connected to the
network and turned on.

To check if a printer is connected correctly over AppleTalk, see if it is visible in the Chooser.
2 Click Print Admin in the AppleShare IP Manager window.
Enter your name and password, then click OK.

The Print Server Activity window appears.

Print Server Activity ———"———0H
Server Status: Running
1l
e |2 ][w]+ o]/ [2]
Queue Name Jobs  Printers  Status
-
[~
0 Queues, 1 Printer | 4 [100] D

3 Ifthe Print Server is not already running, choose Start Print Server from the Server menu.

The Server Status in the activity window shows Running.
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4 Click the New Queue button at the top left of the Print Server Activity window.

The New Queue dialog box appears.

New Queue: Untitled Queue

General %/ Attached Printers \/ Security

Queue Name: [Untitled Queue

[ Enable Queuing — [ Enable Printing

[ Enable &ppleTalk (P4P) B Print job while quening
[ Enable TCRAIF (LPR)

e Adwertise color printing Print Cover Page
A allow binary data ® MNone

(2 Befare each job
() After each job

Cancel I Save “

5 Type a name for the queue in the Queue Name text box.

The name identifies the print queue in the Print Server Activity window and (if this will be an
AppleTalk print queue) in the Chooser.

The name can be up to 31 characters long and can contain any character except a colon (:),
Option-X (»), or an equal sign (=). The name cannot begin with a space character, and it
must be different from the names of other printers or queues in the same zone.

Note: If you decide to make the attached printer invisible in the Chooser (as described in
step 9), the queue name can be the same as the name of the attached printer.
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6 Click the Attached Printers tab.

New Queue: Untitled Queue

General \/ Attached Printers\/ Security

= Kame Hold Hide
(e =

Protocol:[ AppleTalk

Zone: [ East Wing T
Alex

Aphrodite {6300
Art Pro 630
Bailey's Pawprints

3

u

Cancel I Save “

Alist of the printers in the chosen AppleTalk zone appears.

To attach a printer that’s located in a different AppleTalk zone, choose a different zone from
the Zone pop-up menu.

If your network does not have any zones, the pop-up menu is not available.
8 Toattach a printer, select it, then click the Attach Printer button to the left of the printer list.
The attached printer and its AppleTalk zone appear in the Attached Printers list.

If you do not want users to be able to print directly on this printer (rather than through a
queue), select the Hide checkbox to the right of the printer.

New OQueue: Untitled Queue

General / Attached Printers\/Security

Kame Hold Hide
= #phrodite {6300 in East Wing O M [~

Protocol:[ AppleTalk

Zone: [ East Wing
Alex

Art Pro 630
Bailey's Pawprints
Beat L&

Cancel I Save “
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When the printer is hidden, only the queue will appear in the Chooser; it looks like any other
printer name. When the printer is not hidden, both the queue and the printer appear in the
Chooser, and users can choose either one.

Printing directly may be useful for applications that allow the feeding of individual sheets of
paper, such as envelopes.

Click Save.

The queue appears in the Print Server Activity window. When the status line indicates that it
is operating normally, the queue is ready to use.

Print Server Activity=—————-—HH
Server Status: Running
3
EEERISE |
Queue Hame Jobs  Printers Status
= My Main Queus 1] 1 The queue is operating normally. [
A3 tiphrodite (630} in East Wing status: confiquring.
[=|
1 Queus, 1 Printer |4 |_M| |» |2

If you want to attach a printer connected via TCP/IP or learn about other Print Server
options, see the Print Server section in AppleShare IP Help after you complete the
instructions in this manual.

The Print Server is now set up. Go to the next section for information on how to get client
users ready to use AppleShare IP.

Getting Users Ready

Now that you've finished setting up your AppleShare IP services, Apple recommends that
you upgrade your users’ Macintosh computers to Mac OS 8.5 or later; which includes the
AppleShare Client 3.8.1 software. If you do not upgrade the system software on users’
computers, Apple recommends you install the AppleShare Client 3.8.1 software, provided on
your AppleShare IP CD. These upgrades allow users to take full advantage of the features of
AppleShare IP. At a minimum, client users need to have system software 7.6 or later.

Note: Windows clients do not need additional installation or setup.



Upgrading Mac OS Clients

You can make the AppleShare Client 3.8.1 Installer available to Macintosh computers on your
network via the Web & File Server. Follow these steps:

Make sure your client computers have system software 7.6 or later and Open Transport 1.1.2
or later installed. (You can find out the version of Open Transport by opening the TCP/IP
control panel and choosing Get Info from the File menu.) If possible, install Mac OS 8.5 on
all Mac OS client computers.

See an Apple-authorized dealer for information about purchasing this software, or visit The
Apple Store Web site at

http://store.apple.com

Important Do not violate your license agreement by installing the Mac OS 8.5 software that
comes with AppleShare IP 6.1 onto client computers.

To determine the number of client computers onto which you can install the AppleShare
Client 3.8.1 software, see your license agreement.

Open the Web & File Admin program.

Open the AppleShare IP Manager and click the Web & File Admin button. Enter your name
and password, then click OK.

If the Web & File Server is not running, choose Start Web & File Server from the Server
menu.

To see if the Web & File Server is running, check the Status area in the AppleShare IP
Manager window.

Make the Client Software 3.8.1 folder (on the server’s hard disk) a share point, and assign at
least Read Only access privileges to the Everyone category.

For instructions, see “Setting Up Share Points for the First Time” on page 49.
Provide users with the information they need to find the shared folder using the Chooser.

Users should open the Chooser and select the AppleShare icon, the zone in which the Web &
File Server is located, and the name of the server and volume they need to access.

The server name is the computer name that you entered in the File Sharing control panel.
The server zone is the zone you selected in the AppleTalk control panel. The volume they
need to access is the shared Client Software 3.8.1 folder.

Tell users to open the Client Software 3.8.1 folder and install as instructed.

Users should refer to the AppleShare Client 3.8 User’s Manual (in the Client Software 3.8.1
folder) for instructions on how to install and use the client software. The manual also has
information about interpreting access privileges.
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Mac OS Client Services

After Mac OS clients have upgraded their software, they can use AppleShare IP services as
follows.

Using Web & File Services

To use AppleShare file sharing services, users select the AppleShare icon in the Chooser, then
connect to the Web & File Server and access shared files (or volumes).

To use FTP services, client users need to enter an FTP address (for example, “ftp://
myserver.company.com”) in an that supports FTP. (The Web browsers that come with
Mac OS 8.5—Microsoft Internet Explorer and Netscape Navigator~—both support FTP).

To connect to your Web site, client users enter the Web server’s universal resource locator
(URL) into any industry-standard Web browser. The URL is “http://<<DNS name=>,” for
example, “myserver.company.com.” Alternatively, users can type in the IP address for the
AppleShare IP Web & File Server, for example, 172.33.156.88.

Using Mail Service

To connect to the Mail Server, users can use any Internet client mail application that supports
SMTP, POP, IMAP, Finger, or PASS protocols. The client’s e-mail program needs to be
configured with the account name, password, and e-mail address you assigned in the Mail
Admin program. See “Setting Up the Mail Server for the First Time” on page 58.

Using Print Service

» To use the Print Server over AppleTalk, Mac OS client users need to have version 7 or 8 of
the LaserWriter printer driver installed.

» To use the Print Server over TCP/IP, clients need to have LaserWriter 8.5 or later installed;
this software is provided in Mac OS 8.1 or later.

» To use password-protected printing, clients need to have LaserWriter 8.6.1 installed.

It’s best to upgrade all Mac OS clients on your network to use the same version of the printer
driver.

To check the version number of the printer driver, select the LaserWriter icon in the
Extensions folder (inside the System Folder) and choose Get Info from the File menu.

Windows Client Services

AppleShare IP provides file sharing (via AFP and SMB), FTP, Web, mail, and print services for
Windows 95, Windows 98, and Windows NT users.

Note: As the AppleShare IP administrator, you should be aware of the differences between
administering for Windows and Mac OS users to avoid file sharing problems. For Windows
file sharing and naming guidelines, see the Windows File Sharing section in the Web & File
Server section of AppleShare IP Help.



Windows File Sharing Service

Windows 95, Windows 98, and Windows NT computers have built-in support for the
Windows file sharing protocol, SMB, supported by AppleShare IP.

Web and FTP Service

Windows 3.0 and later, Windows 95, Windows 98, and Windows NT users can connect to the
Web & File Server via any standard Web browser or FTP application.

Mail Service

Windows 3.0 and later, Windows 95, Windows 98, and Windows NT users can use the Mail
Server if they have installed a POP, IMAP, SMTP, Finger, or PASS-compliant client mail
application.

Print Service

Windows 95 and Windows 98 users can use the Print Server if they have installed an
AppleTalk-compatible printer driver or an LPR-compatible TCP/IP print driver. (Windows NT
computers have built-in LPR support.)

Windows 95 and Windows 98 users can print using any AppleTalk-compatible print software,
or TCP-compatible printers that support the LPD/LPR protocol.

Note: Windows 95, Windows 98, and Windows NT do not support password-protected
printing.

For more information about administering AppleShare IP services or troubleshooting
problems that may arise while using the software, see AppleShare IP Help.
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APPENDIX

Changing the Startup Disk

The AppleShare IP servers use several files located in the System Folder of your startup disk.
If you change your startup disk after you install any of the AppleShare IP server programs,
you need to install AppleShare IP on the new startup disk and copy certain files and folders
from the old startup disk to the new startup disk.

This appendix provides instructions for two scenarios:
» adding a new disk, making it the startup disk, and keeping the old disk
» replacing the startup disk

Depending on whether you add or replace a startup disk and which AppleShare IP servers
are installed on your computer, you may skip some of the steps in this appendix.

To change the startup disk, follow these steps:

Shut down your computer and connect the hard disk you want to use as the startup disk.
See the manual that came with your computer for detailed instructions.

Restart your computer.

Make sure that the new hard disk has a different name from the startup disk.

Install Mac OS 8.5 and the AppleShare IP 6.1 software on the new hard disk.

For instructions, see Chapter 1, “Installing Your Software,” on page 9.

Copy the Users & Groups Data File from the Preferences folder inside the System Folder on
your startup disk to the same location on the new hard disk.

If your computer is being used to run the Web & File Server, copy the AppleShare IP
Preferences folder from the Preferences folder inside the System Folder on your startup disk
to the same location on the new hard disk.

If you are replacing your startup disk and if your computer is providing Web service, copy
the default Web folder (defined in the Web & File Server Settings window) from your
startup disk to the new hard disk.
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This step is not necessary if you are adding a new startup disk and you plan to use both
hard disks.

If you are replacing your startup disk and if your computer is being used to share data, use
the Web & File Admin program’s Duplicate Folder command to copy shared folders from
the startup disk to the new hard disk.

Do not use the Finder to copy the folders because the folders’ access privileges will not be
retained. For information about the Duplicate Folder command, see the Web & File Server
section of AppleShare IP Help.

If you are replacing your startup disk and your computer is being used to run the Mail
Server, copy the AppleShare IP Mail Folder from your startup disk to the new hard disk.

This step is not necessary if the AppleShare IP Mail Folder is not on your startup disk.

If you are replacing your startup disk and if your computer is being used to run the Print
Server, copy the Print Server Preferences folder from the Preferences folder inside the
System Folder on your startup disk to the same location on the new hard disk.

If you have set up the Print Server to use a different folder, copy that folder instead.

Open the Startup Disk control panel and click the icon of the disk you want to use as the
startup disk.

Choose Restart from the Special menu.

The disk that you selected in step 11 becomes the startup disk. After the computer has
restarted, start the AppleShare IP Manager from the new startup disk.

If you are replacing your startup disk and if your computer is being used to run the Mail
Server, use the Mail Admin program to change the mail storage volume.

This step is not necessary if the AppleShare IP Mail Folder is not on your startup disk. For
information on determining the location of the AppleShare IP Mail Folder, see the Mail
Server section of AppleShare IP Help.

If you are replacing your startup disk and if your computer is being used to run the Print
Server, use the Print Admin program to change the folder in which jobs are stored.

For information on determining the folder that the Print Server is using to store jobs, see
the Print Server section of AppleShare IP Help.

If your computer is being used to run the Web & File Server, start the Web & File Server
and verify that all services are working as expected.

Verify that folders are being shared correctly. If Web service is enabled, use the Web & File
Admin program to verify and set the location of the default Web folder and default
document file (defined in the Web & File Server Settings window). If FTP service is
enabled, verify that it is working correctly.
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If your computer is being used to run the Mail Server, start the Mail Server.

Verify that the Mail Server is using the correct mail database by checking the Mail Server log.

For information, see the Mail Server section of AppleShare IP Help.
If your computer is being used to run the Print Server, start the Print Server.

Verify that the Print Server is working correctly by checking the Print Server log. For
information, see the Print Server section of AppleShare IP Help.

If you are replacing your startup disk, stop each AppleShare IP server and shut down your
computer. Remove the former startup disk (making sure that the SCSI chain is terminated
correctly) and restart your computer.

Repeat steps 1517 to verify that the servers are working correctly.

Changing the Startup Disk
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